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SECTION ONE: 
OVERVIEW

WHAT IS MAGIC BULLET EDITORS?

Magic Bullet is a finishing tool for digital movies, commercials and web 
productions. Developed at The Orphanage, a digital film production and post-
production company (see Appendix 3, p.49), it was designed to allow ultimate 
creative control over digital projects while maintaining the highest possible 
quality, with a particular eye towards mimicking the characteristics of motion 
picture film inside your video editor.

Magic Bullet Editors brings the power of Look Suite, a tool for mimicking 
various film processes and shooting styles and a brand-new tool, Misfire 
for generating a wide variety of film characteristics. These tools run inside 
popular video editing tools including Adobe Premiere Pro, Apple Final Cut Pro, 
and Sony Vegas as plug-ins. 

 Please note that while Magic Bullet was invented at The Orphanage, all sales, 
support, and marketing inquiries should be directed to Red Giant Software at 
www.redgiantsoftware.com or (415) 274-2000.
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WHAT’S MAGIC BULLET EDITORS?

LOOK SUITE

Look Suite is the creative centerpiece of Magic Bullet. Here you will find a 
selection of more than 50 preset Looks that you can apply to your footage, 
or you can design your own. The preset Looks are designed to mimic a 
number of popular shooting styles and post-processes. In addition, Look 
Suite provides you the power to create your own unique looks for your 
projects and save them to use again or share with others.

MISFIRE

While Look Suite provides the power to emulate film stocks, and mimic 
popular shooting styles, Misfire delivers the tools to emulate a whole suite 
of film qualities from subtle grain to vignettes to artistic scratches, dust and 
more. Misfire is meant to follow Look Suite in most cases offering film-like 
damage to your image. Where Look Suite is meant to sweeten your image, 
Misfire will let you mangle your image in numerous ways.

DUAL PLATFORM CD

The CD version of Magic Bullet Editors contains three installers for three 
different non-linear editors. On the Mac OS partition, you will find the 
installer for Final Cut Pro 4.1 and later. On the Windows side, you will 
find installers for both Adobe Premiere Pro 1.5 and Sony Vegas 5.0. All 
supported products also have a corresponding tutorial project and footage on 
the CD.
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INSTALLATION

MAC OS SYSTEM REQUIREMENTS

Apple Power Mac G4 or G5 (dual-processor recommended)
Apple Final Cut Pro 4.1 or HD (4.5)
Mac OS X 10.2 or later and 512 MB of RAM or more

WINDOWS SYSTEM REQUIREMENTS

Intel Pentium 4 single or dual-processor system or equivalent
Adobe Premiere Pro 1.5
Avid Xpress Pro 4.1.1 (or other AVX 1.5 compatible system)
Sony Vegas 5.0
Windows XP and 512 MB of RAM or more

INSTALLING MAGIC BULLET EDITORS

We’ll bet you’ve inserted the Magic Bullet Editors CD and run the installer 
before ever looking at this manual, and that is indeed the first step in 
installing the plug-ins for your editing application.

The installer will find any copies of Final Cut Pro on Mac OS or Premiere Pro 
1.5 on Windows and drop two items into the Plug-ins folder: Look Suite, and a 
folder called Misfire which contains the 14 Misfire plug-in components. If you 
are using Avid Xpress Pro or Sony Vegas you will also find an installer on the 
Windows disc as well in the apprpriate folder.

During the install you will prompted for a serial number to authorize your 
individual copy. This serial number is tied to your purchase. If you do not enter 
a serial number during installation, you can run the software in demo mode. 
Demo mode renders a logo over your footage. If you want to authorize your 
copy after choosing demo mode, please run the installer again and enter the 
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serial number when prompted.

If you are not able to get Magic Bullet Editors functioning even after re-
installing, and rebooting, contact Red Giant Software support by sending 
email to support@redgiantsoftware.com. You can also access technical 
information on our website at www.redgiantsoftware.com.

QUICKDRAW: GETTING STARTED WITH LOOK SUITE

To get you started with Look Suite quickly, we will open a project and build a 
look from scratch that is suited to the footage in the demo project. 

You will need either Apple Final Cut Pro 4, Adobe Premiere Pro 1.5, Sony 
Vegas 5.0. We have included the footage in DV format for you to work with 
and a starter project with a sequence ready for Look Suite.

FINAL CUT PRO 4

Start by opening the Magic Bullet Editors Demo project. You should copy this 
file and the media to your local or media drive before starting the project. This 
will speed up the interactivity and let you save your changes if you desire.

We are going to create a look that makes the opening 11 seconds or so of 
our movie feel more cold and distant—to emphasize the feeling in the scenes. 
The following instructions assume that you have a basic understanding of the 
Final Cut Pro interface.

Before you start applying Look Suite please play the sequence without any 
effects to get an idea of the overall mood of the project.

Open the Look Suite Sequence if it isn’t already open. 

Click on the Cool Look clip at the beginning of the timeline. Make sure the Play 
Head is at time 01:00:03:01.

mailto://support@redgiantsoftware.com
http://www.redgiantsoftware.com
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The Look Suite effect controls 
in Final Cut Pro 4.
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From the Effects menu choose Video Filter > Magic Bullet > Look Suite.

 You will then notice that nothing in the Canvas window changed. The default 
Look Suite does not make any changes to the image. You will enter values in 
the various controls to change your image.

Double-click on the Cool Look clip and choose the Filter tab in the Viewer 
window. You will see the Look Suite filter controls ready for editing.

The first change you will make is in the Subject controls. Enter –35 in the Pre 
Saturation control and –25 in the Pre Contrast. This immediately flattens out 
the look of the scene.

Next we will add a bit of both Black Diffusion and White Diffusion. In the Black 
Diffusion controls set Grade to 2.5, Size to 25 and Highlight Bias to –30. This 
softens the shadows in the image.

Now enter the following changes in the White Diffusion controls. Set the Grade 
to 1, Size to 2 and Highlight Bias to 85. This will soften up the highlights.

Scroll down to the Tint Black and set the value to 62.5 and the Tint Black 
Threshold to 16.67. This will strongly tint the darkest shadow areas to blue, 
making the image feel colder.

Finally, lets give an overall cool feel by setting the Post values. Set the Warm/
Cool control to 3, and the Gamma to –2. This makes the image look bluer and 
lighter. Set the Post Contrast to 58 and the Post Saturation to –30. Now the 
image has punch and overall coloration is a sort of steel blue. 

Congratulations you have just created your first “Look”. The Dream Look 
clips already have a warm soft look applied to it. To complete the sequence, 
you should copy the Look Suite effect from the first clip to the last in the 
sequence. 

 You will find a host of Look Suite favorites in the bin in the demo project or you 
can load and copy the Look Suite Favorites project from the package. You can 
simply apply these to your clips by dragging and dropping. Once applied you 
can modify the values to suit your particular clips.

Feel free to render the project to get an idea of how the addition of Look Suite 
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has changed the mood of this short story. On a Power Mac G5 this should 
take just a few minutes, slower machines will obviously take longer to render.

 Final Cut Pro 4.1 and later does not let effects like Look Suite store and 
recall presets. This is a limitation of Final Cut Pro and its support of the 
After Effects plug-in API. Instead you can use the Look Suite Presets that are 
loaded as part of the demo project or by simply loading and copying the effect 
favorites into your project bins as necessary. 

ADOBE PREMIERE PRO 1.5

Start by opening the Magic Bullet Editors Demo project. You should copy this 
file and the media from the Source folder to your local or media drive before 
starting the project. This will speed up the interactivity and let you save your 
changes if you desire. 

We are going to create a look that makes the opening 11 seconds or so of 
our movie feel more cold and distant—to emphasize the feeling in the scenes. 
The following instructions assume that you have a basic understanding of the 
Final Cut Pro interface.

Before you start applying Look Suite please play the sequence without any 
effects to get an idea of the overall mood of the project.

Open the Look Suite Sequence if it isn’t already open. 

Click on the Cool Look clip at the beginning of the timeline. Make sure the Play 
Head is at time 00:00:03:01.
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The Look Suite effect controls 
in Adobe Premiere Pro 1.5.
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From the Effects tab choose Video Effects > Magic Bullet > Look Suite. Drag 
and drop this effect onto the timeline clip named “Cool Opening”

 You will then notice that nothing in the Canvas window changed. The default 
Look Suite does not make any changes to the image. You will enter values in 
the various controls to change your image.

Double-click on the Cool Opening clip and select the Effect Controls window 
in the Viewer. You will see the Look Suite filter controls. Open the disclosure 
triangles to reveal the controls.

The first change you will make is in the Subject controls. Enter –35 in the Pre 
Saturation control and –25 in the Pre Contrast. This immediately flattens out 
the look of the scene.

Next we will add a bit of both Black Diffusion and White Diffusion. In the Black 
Diffusion controls set Grade to 2.5, Size to 25 and Highlight Bias to –30. This 
softens the shadows in the image.

Now enter the following changes in the White Diffusion controls. Set the Grade 
to 1, Size to 2 and Highlight Bias to 85. This will soften up the highlights.

Scroll down to the Tint Black and set the value to 62.5 and the Tint Black 
Threshold to 16.67. This will strongly tint the darkest shadow areas to blue, 
making the image feel colder.

Finally, lets give an overall cool feel by setting the Post values. Set the Warm/
Cool control to 3, and the Gamma to –2. This makes the image look bluer and 
lighter. Set the Post Contrast to 58 and the Post Saturation to –30. Now the 
image has punch and overall coloration is a sort of steel blue. 

Congratulations you have just created your first “Look”. The Dream Look 
clips already have a warm, soft look applied to it. To complete the sequence, 
you should copy the Look Suite effect from the first clip to the last in the 
sequence. 
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 You will find a host of Look Suite Presets in the Effects tab. These are loaded 
under the Look Suite Presets category and included all 55 presets. You can 
simply apply these to your clips by dragging and dropping. Once applied you 
can modify the values to suit your particular clips. You can save a variation 
or make your own preset just by right clicking on the Look suite effect in the 
Effect Controls window and choosing the Save Preset... command from the 
right-click menu.

Feel free to render the project to get an idea of how the addition of Look Suite 
has changed the mood of this short film. 

SONY VEGAS 5.0

Start by opening the Magic Bullet Editors Demo.veg project. You should copy 
this file and the media from the Source folder to your local or media drive 
before starting the project. This will speed up the interactivity and let you 
save your changes if you desire. 

We are going to create a look that makes the opening 11 seconds or so of 
our movie feel more cold and distant—to emphasize the feeling in the scenes. 
The following instructions assume that you have a basic understanding of the 
Sony Vegas interface.

Before you start applying Look Suite please play the sequence without any 
effects to get an idea of the overall mood of the project.

Open the Look Suite Sequence if it isn’t already open. 

Click on the Cool Look clip at the beginning of the timeline. Make sure the Play 
Head is at time 00:00:03:01.
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The Look Suite effect controls 
in Sony Vegas 5.0.
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Click the Event FX... button for the first clip on track 3. This clip is named 
“Cool Opening”. The Video Effects chooser will appear. Click the Magic Bullet 
Editors effect and click OK.

 You will then notice that nothing in the Video Viewer window changed. The 
default Look Suite does not make any changes to the image. You will enter 
values in the various controls to change your image.

The Video Event FX window should now be open. You will see the Look Suite 
filter controls.

The first change you will make is in the Subject controls. Enter –35 in the Pre 
Saturation control and –25 in the Pre Contrast. This immediately flattens out 
the look of the scene.

Next we will add a bit of both Black Diffusion and White Diffusion. In the Black 
Diffusion controls set Grade to 2.5, Size to 25 and Highlight Bias to –30. This 
softens the shadows in the image.

Now enter the following changes in the White Diffusion controls. Set the Grade 
to 1, Size to 2 and Highlight Bias to 85. This will soften up the highlights.

Scroll down to the Tint Black and set the value to 62.5 and the Tint Black 
Threshold to 16.67. This will strongly tint the darkest shadow areas to blue, 
making the image feel colder.

Finally, lets give an overall cool feel by setting the Post values. Set the Warm/
Cool control to 3, and the Gamma to –2. This makes the image look bluer and 
lighter. Set the Post Contrast to 58 and the Post Saturation to –30. Now the 
image has punch and overall coloration is a sort of steel blue. 

Congratulations you have just created your first “Look”. The next clips in Track 
3 already have the Dream Look applied giving these clips a warm, soft look.

To complete the sequence, you should create a new Preset effect and apply 
it to the final clip on Track 3. Just like other Vegas effects, you can create a 
new preset just by assigning the preset a name and clicking the Save Preset 
button to the right of the pop-up list.
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 You will find a host of Look Suite presets under the Magic Bullet Editors 
category in the Video Effects tab.  You can simply apply these to your clips by 
dragging and dropping. Once applied you can modify the values to suit your 
particular clips. 

Feel free to render the project to get an idea of how the addition of Look Suite 
has changed the mood of this short film by using the Render As... command 
from the File menu.

AVID XPRESS PRO 4

Start by opening the Magic Bullet Editors Demo project. You should copy the 
Avid Demo Project folder and the media from the Source Footage folder to 
your local or media drive before starting the project. This will speed up the 
interactivity and let you save your changes if you desire. You can access the 
project as External project by browsing to the directory in the Avid Open 
Project interface. You may need to Relink the media in the bins before you get 
started.

For this project, you are going to create a look that makes the opening 11 
seconds or so of our movie feel more cold and distant—to emphasize the 
feeling in the scenes. The following instructions assume that you have a basic 
understanding of the Avid Xpress Pro interface.

Before you start applying Look Suite please play the sequence without any 
effects to get an idea of the overall mood of the project.

Open the Demo Sequence if it isn’t already open. 

Click on the Opening.sub clip at the beginning of the timeline. Make sure the 
Play Head is located within the first 11 seconds.
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The Look Suite controls in 
the Avid Xpress Pro Effects 
Editor window.
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Click the Effects tab in the Project window or open the Effects Palette from the 
Tools menu. Click on the Magic Bullet category. Drag and drop the Look Suite 
effect from the palette of project window to the clip named “Opening.sub” on 
the timeline.

 You will then notice that nothing in the Composer window changed. The default 
Look Suite does not make any changes to the image. You will enter values in 
the various controls to change your image.

Click the Effect Mode button in the timeline to reveal the Effects Editor. You 
will see the Look Suite filter controls in the Effects Editor. Look Suite is divided 
into 5 sections. A presets menu, Load and Save presets button are at the 
top. The remaining controls are divided by the “DO” switches that turn on and 
off the sections of Look Suite

The first change you will make is in the Subject controls. Enter –35 in the Pre 
Saturation control and –25 in the Pre Contrast. You can use the sliders are 
enter values numerically with the numeric keypad. This immediately flattens 
out the look of the scene.

Next we will add a bit of both Black Diffusion and White Diffusion. In the Black 
Diffusion controls set Grade to 2.5, Size to 25 and Highlight Bias to –30. This 
softens the shadows in the image.

Now enter the following changes in the White Diffusion controls. Set the Grade 
to 1, Size to 2 and Highlight Bias to 85. This will soften up the highlights.

Scroll down to the Tint Black and set the value to 62.5 and the Tint Black 
Threshold to 16.67. This will strongly tint the darkest shadow areas to blue, 
making the image feel colder.

Finally, lets give an overall cool feel by setting the Post values. Set the Warm/
Cool control to 3, and the Gamma to –2. This makes the image look bluer and 
lighter. Set the Post Contrast to 58 and the Post Saturation to –30. Now the 
image has punch and overall coloration is a sort of steel blue. 

Congratulations you have just created your first “Look”. The next clips in Track 
3 already have the Dream Look applied giving these clips a warm, soft look.

To complete the sequence, you should copy the Look Suite effect applied to 
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“Opening.sub” to the final clip on V1 called “Ending.sub”. You can create a new 
preset just by clicking the Save Preset button at the top of the effect. You will 
then be prompted for a destination and name for the effect. You could name 
this effect “Cool Opening”. If you want to use this effect in another sequence 
or project, you can load this new look using the Load Preset buton.

 You will find a host of Look Suite presets under the pop-up menu that is 
labelled None when you first apply the effect.  You can simply apply these 
presets to your clips or nests by simply selecting a name from the menu. 
Once applied you can modify the values to suit your particular clips. 

Feel free to render the project to get an idea of how the addition of Look Suite 
has changed the mood of this short film by using the Export... command from 
the File menu.
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PREPARING FOR LOOK SUITE

Turn Down the Sharpening

If your camera has the option, reduce the internal sharpening control to 
almost none. The harsh, over-sharpened edges that appear on high-contrast 
images are a signature of DV video. It’s worth experimenting with your 
camera’s settings to find the best sharpening amount, but it will almost 
certainly be less than the default setting.

Don’t Overexpose

DV does not react well to blown-out areas of the frame. If a hot or 
overexposed look is your desire, it’s far better to shoot at a normal exposure 
and use Magic Bullet Look Suite to burn it out later.

Many cameras have an option to display a zebra pattern in the viewfinder over 
areas that are blown out to 100% white. This is a very helpful option when 
shooting with Look Suite correction in mind.

An ND Grad filter can help keep sunny skies from blowing out, and putting one 
on the camera will even do a better job than Look Suite’s built-in Grad feature!

For an in-depth discussion of grad filters, see the Look Suite chapter in the 
Reference section.

Don’t Underexpose

DV doesn’t react well to dark areas either! Brightening up a dark DV shot will 
bring out all the compression and noise that you never knew was there.

Shoot it Plain

As an owner of Magic Bullet Editors, you have a very powerful image 
adjustment tools at your fingertips. Shoot your footage as “normal” looking as 
possible, and wait until you get it into Look Suite to create those crazy looks 
you have in mind. This gives you the power and control to change your mind 
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about how you want it to look. This means avoiding color or diffusion filters on 
the camera (with the exception of the ND Grad mentioned above), and setting 
the white balance to the correct preset for the type of light you’re using.

Shoot it Consistent

The best favor you can do for yourself is to ensure that shots in the same 
sequence look similar to one another. Watch not only the lighting on your 
foreground subject, but that of your backgrounds as well. Use presets for 
white balance, so that even if your battery goes dead and you lose your 
camera settings, you can still return to the same color balance you were 
using before. Use a color monitor on the set to compare playback of your last 
setup to the feed from the current one. Try to keep all of your similar skin 
tones in the same exposure range from one shot to the next—some cameras 
have zebra patterns in their viewfinders that help you do this. Finally, create a 
pre-flight checklist for your camera that combines these guidelines with your 
own experiences, and run through it before beginning every new shot.

As with any advice, please take the above into consideration and make your 
own decisions. These guidelines have worked well for The Orphanage, but 
there could be any number of reasons that you may need to do something 
different. Look Suite should be flexible enough to give you great looks on a 
wide array of footage, but if you follow the above guidelines you are on the 
road to superior results.
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SECTION TWO: 
REFERENCE

Here you will find descriptions of every parameter and preset in the plug-ins 
included in Magic Bullet Editors. The power of Look Suite includes explanations 
of how the controls relate to traditional, non-digital filmmaking techniques. 
The Misfire description includes examples of how each control will change the 
final image.

LOOK SUITE

Look Suite is a powerhouse plug-in with many controls and features. We 
could have split Look Suite in to about nine different plug-ins, but that would 
prevent the easy loading and saving of presets. So instead you’ll find that Look 
Suite is broken up into several sections. Let’s take a look at them one by one, 
referencing some DVDs from our library (see Appendix 2, p. 41) as we go.

PRESET LOOKS

If you are running Look Suite under Final Cut Pro, there is no preset menu in 
the plug-in. This is a change from the After Effects version that some users 
may be familiar with. For Final Cut Pro, the preset Looks are stored in a set of 
Bins in the project titled Look Suite Favorites.

The presets that ship with Magic Bullet Editors don’t do anything you couldn’t 
do yourself with Look Suite’s various controls, but they have been painstakingly 
set up to match some common looks found in TV and films, so that you can 
see right away how Look Suite can help you create extremely high-quality 
cinematic output from your video source. The Looks that ship with Magic 
Bullet Editors include:
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Basic This Look is the simplest simulation of the 
basic look of film the way most people think 
about it. Many video source will look good 
treated with this Look.

Basic Cool Every car commercial that doesn’t need Basic 
Warm needs Basic Cool—check out the Detroit 
scenes in Out of Sight and you’ll get the idea.

Basic Cool Max Similar to Basic Cool this look has a very 
strong blue tinge and heavy contrast.

Basic Warm The simplest recipe for creating a warm, 
inviting look. A little bit of White Diffusion and a 
subtle nudge of the Warm/Cool slider.

Basic Warm Max Takes the Basic Warm and adds great warmth 
and contrast. This maximizes the warming 
effect. Try this when you want a very hot look 
you may want to dial in some values to your 
taste.

Basic White Diffusion The Basic Look with a hearty dose of White 
Diffusion. Highlights will bloom out a bit and 
video artifacts will be nicely concealed.

Basic Black Diffusion The Basic Look with Black Diffusion. Less 
glowing than the White Diffusion, Black 
Diffusion reduces contrast without muddying 
the image. Counteracting this with a bit of 
Post Contrast creates a rich, warm look.

Basic Black and White A rich, contrasty black and white look.

Those are the Basic Looks—they are designed to help familiarize you with 
the broad-strokes controls in Look Suite. The following Looks go deeper into 
Looks Suites abilities to emulate specific film processes and treatments 
common in movies, TV and commercials today.
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Aged Look Suite can be used to create looks that 
enhance or a look that degrades the image. 
This look adds brown tones, softness, and 
contrast to give you image the look of a 
mishandled negative.

Auto-Art Imagine a black and white film shot on 16 mm  
film stock with too much contrast and soft 
shadow areas. Use sparingly.

Berlin This look is best described as sallow, cold, and 
pale. Try this look when you want a distant, 
cold feeling in a scene.

Bistro This film look was inspired by the pearly 
greens and soft golden images found in the 
foreign hit Amélie.

Black Diffusion 5.0 The Basic look with Black Diffusion setting of 
5, similar to a Black Diffusion filter of grade 
5. Black Diffusion reduces contrast without 
muddying the image.

Bleach Bypass Made famous on films such as Saving Private 
Ryan, this process, also called “skip bleach” 
or “ENR” involves skipping the portion of 
standard color negative film developing in 
which the image silver is bleached from the 
negative. The silver remains on the film along 
with the image dyes throughout the remainder 
of the developing. The result is greatly 
increased contrast and reduced saturation, 
since essentially more black is mixed in with 
the dyes. The look can be beautiful, but the 
process is risky since you may only get one 
shot at it (this is your negative after all) and 
any miscalculations in exposure could result in 
important image information falling off into inky 
blackness. The Movie Looks’ digital version of 
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Bleach Bypass is 100% undoable, adjustable, 
and safe for children of all ages.

Bronze A warm but low saturation look is best used 
on darker footage. This version will lighten your 
footage.

Buffalo Similar to a color reversal film look the final 
result is extremely contrasty with super-
saturated colors. See the Color Reversal notes 
below for more detail.

B&W Crunch This is a basic black and white look but with a 
large amount of contrast perfect for a dark noir 
scene.

Color Reversal  Color reversal film stock is the opposite of 
color negative. Exposure density is converted to 
transparency on the film rather than darkness, 
so that the actual film original that ran through 
the camera can be projected as a positive 
image with correct color. This is the case 
with old Super-8 film for example — the film 
you project is the film you shot. Slide film is 
also color reversal. Reversal film, contrastier 
to begin with, involves an extra duplication 
step (internegative to interpositive), so the 
final image is extremely contrasty with super-
saturated colors. Some scenes in the film Three 
Kings were shot this way

Coolish This look delivers the same cool look as Basic 
Cool but with less diffusion and about half as 
much blue tint. 

Curahee Similar to the Bleach Bypass look, this preset 
was inspired by the tone of the mini-series Band 
of Brothers. Try this look on your next war epic.



SE
CT

IO
N

: 
R

EF
ER

EN
C

E

 24  M A GIC  B U LLET  ED ITO RS

SECTIO
N

: R
EFER

EN
C

E

  M A GIC  B U LLET  ED ITO RS 25

Diffusion Max This  preset combines the Black Diffusion 5.0 
and White Diffusion 5.0 presets to give you a 
glow across the entire image. This is great as 
a special effect and similar stylization can be 
seen in show promos and openers on television.

Diffusion Soft Portrait This preset adds a gold tint and a bit of 
warming to make close-ups look soft and 
pleasing. Try it on your next full face shot.

Edge Noise Soften This looks doesn’t change the contrast or tone 
much but it uses the black and white diffusion 
capabilities in the look suite engine to soften 
the edges and mask noise in an image. This is 
not a cure all but it does work well in hiding DV 
camera sharpening artifacts in some cases.

Epic When true color was first introduced to the 
world of motion picture film in 1932, it was 
in the form of glorious Technicolor. This was 
a three-strip process — in other words three 
black and white negatives were exposed at the 
same time in a special camera, one for red, 
one for green, and one for blue. Not dissimilar 
to how modern high-end digital video cameras 
devote one photosensitive CCD chip each to 
the R, G and B channels, these cameras used 
a prism to distribute filtered light to it’s three 
individual film gates. The three processed 
negatives would then be united onto one piece 
of print film using a process called dye transfer. 
The results astounded audiences, and created 
a recognizable look that distinguishes the early 
era of color filmmaking. A small addition of Look 
Suite’s 3-Strip Process slider plus Post Contrast 
and Saturation adjustments allow the Epic look 
to recreate this classic style.
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Gold Crunch A specialty look not for the faint of heart, this 
look offers a pale gold tone and very strong 
contrast that may work well on high-key shots.

Grad Deep Blue If you want to make your skies a richer blue 
(like it was shot through a gradient lens) and 
need the added contrast of the Basic look then 
this preset is for you. This look is best used on 
outdoor shots.

Grad Sky Add a subtle richness to skies without changing 
the overall tone dramatically. This look is best 
used on outdoor shots.

Grad Sunset Perfect for those sunset or sunrise shots with 
a nice open horizon, this looks emulates the 
smokey tint of a camera filter. This look will 
add richness to the reds to make sunsets look 
grand. This look is best used on outdoor shots.

Green Pearl A super soft look that couldn’t be achieved in 
anything but a post-process, this look makes 
the image diffuse and tilts the color strongly 
toward green. This is a good special effect look 
but keep it away from close-ups of your talent.

Max Contrast If you are just looking to really maximize the 
contrast of your image this simple look is all 
you need.

Mexicali Inspired by the sepia tone colors and the blown 
highlights in the film Traffic, this look delivers 
very stark contrast, lots of diffusion and an 
extremely strong red and yellow cast. Try 
altering the Post Gamma control to suit your 
image.
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Miami Taking a cue from early Michael Bay films such 
as Bad Boys, this amber-grad heavy look is also 
similar to the type of photography Tony Scott 
made popular in the early nineties. These guys 
taught us that the heavy use of tinted grad 
filters wasn’t just for sunset shots anymore.

Night Time A night simulation filter this is best used on 
image that start light or have a lot of detail in 
the mid tone and lighter parts of the image. 
Try turning the Blend with Original control up to 
20-30% if this makes your footage too dark.

Neo In The Matrix the filmmakers hinted to us 
that the world as we know it was in fact a 
computerized simulation by subtly coloring all 
scenes that took place within the Matrix itself a 
greenish color, reminiscent of the green text of 
a computer terminal. Magic Bullet’s Neo Look 
does this with a combination of the Tint Black 
control and the Warm/Cool slider with Warm/
Cool Hue moved into the green range. 

No 85 No 85 means “no 85 filter,” referring to 
the common practice of shooting indoor-
balanced film (calibrated for the warmer 
color temperature of incandescent lights) 
out-of-doors (where the color temperature is 
much higher and therefore bluer) without the 
standard correction filter, which is called an 85 
Filter. The 85 filter is like amber-tinted shades 
for your camera, and it makes the tungsten-
balanced film see daylight “correctly.” Some 
cinematographers like to shoot without this 
filter though, and color-correct the blue cast 
out of the image later. They claim that this 
inevitably leaves traces of the blue coloration 
behind, especially in the shadow areas, which 
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can give a cool edge to the blacks in the image.

Ohio Inspired by the strong blue tone colors and 
the white highlights in the home scenes in the 
movie Traffic, this look delivers very strong 
contrast, some diffusion and a heavy purple 
cast to your image.

Pale Olive Another black and white look but this one offers 
a distinct yellow or olive tone. You can control 
the tone by adjusting the value in the Warm/
Cool Hue control

Pastel Cuban Inspired by a look from a television commercial 
for one of our favorite beverages, this look has 
strong pastel tints and low saturation which 
delivers a style all its own.

Pastel Low Contrast This look takes away a lot of saturation and 
gives your images a flat appearance, color tend 
toward pastel tones. This one is best used on 
strong sunlit outdoor scenes.

Punchy For TV commercials and music videos where 
an extremely stylized look is desired, directors 
and cinematographers will push the controls on 
the telecine film transfer machine to eleven. Be 
careful if your original footage is already very 
saturated—this look can be too much.

Sepia The basic Sepia Look delivers the standard 
black and white archival look with a slightly 
warm gray tone to your image. Try this look as 
an alternate to the Basic Black and White look.

Sepia Red Sepia Red delivers the same black and white 
archival look but with a strong red tone similar 
to the look of some early films.
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Sharp If you are looking for a little more punch than 
the Basic look offers then look no further. The 
Sharp preset has slightly smaller diffusion and 
more aggressive contrast. You may turn to this 
preset again and again.

Soft Skin This plug-in is a great basic tool for cutting 
down the hard edges in bright skin tones. The 
combination of a bit of white diffusion and 
gamma correction will give your talent a much 
more pleasing look. Try it on head shots, close 
ups or any time you need to make your talent 
look their best.

Tint Coral Similar to a pink or coral tinted camera filter, 
this looks gives a pink tone to the whole image 
while preserving color saturation. This look also 
adds some contrast to the original footage.

Tint Fuchsia Similar to a fuchsia or light purple tinted 
camera filter, this look gives a violet tone to the 
whole image while preserving color saturation. 
This look also adds some contrast to the 
original footage.

Tint Sapphire Similar to a dark blue tinted camera filter, this 
looks gives a dark navy blue tone to the whole 
image while preserving color saturation. This 
look also adds more contrast and darkening to 
the original footage.

Tint Strong Blue This look is similar to Tint Sapphire but use 
a more saturated blue and has less of a 
darkening effect on your footage.

Tint Warm Heavy Adds a strong orange coloration that is similar 
to a warming filter but the tone is different. Try 
this look on indoor shots.



SE
CT

IO
N

: 
R

EF
ER

EN
C

E

 3 0  M A GIC  B U LLET  ED ITO RS

SECTIO
N

: R
EFER

EN
C

E

  M A GIC  B U LLET  ED ITO RS 31

Tropico Wash Try this on your next outdoor shot. This look 
flattens the highlights and gives a strong 
sunlight warmth, washing a lot of saturation out 
of your footage.

Un-Bloom If you aim is soften our image and lower the 
contrast, this look will deliver. The result comes 
from a inverted contrast setting and black 
diffusion that is set to effect most of the image 
except the highlights.

Warmish This look delivers the same warm look as Basic 
Warm but with less diffusion and about half the 
warm setting. 

Warm & Fuzzy Inspired by the film Jerry Maguire, this look 
mixes a bit of White Diffusion with a subtle 
warmth that can really make actors (or 
actresses) look more pleasing.

White Diffusion 5.0 The Basic look with a big dose of white 
diffusion. Highlights will bloom out a bit and 
video artifacts may be nicely concealed.

Now that you’ve explored some of the Preset Looks, let’s take a look at the 
controls that you can use to create your own. A great way to get started is 
to apply a preset and see what its sliders look like, and then start editing it to 
create your own custom version of that Look. Before long you’ll be cooking up 
Looks from scratch and saving your own libraries.
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 The various parameters in Look Suite are listed in operational order, meaning 
that the first ones happen first, on down to the very last parameter.

 Look Suite is not a color correction tool—it is designed to be used on footage 
that has already been color corrected to have even and consistent contrast, 
gamma, and color characteristics. Apply Look Suite after your favorite color 
correction plug-ins—this way you can use one Look with no keyframes on a 
whole scene and get beautiful results!

Now we’ll dive in to the various effects and sliders within Look Suite. Reading 
through this section carefully will not only give you all the knowledge necessary 
to begin designing your own Looks, it may answer some nagging questions 
you’ve had about why film images look the way they do.

FOUR CATEGORIES, ONE PLUG- IN

Look Suite’s many effect controls are broken down in to four categories: 
Subject, Lens Filters, Camera and Post. Each category is discussed separately 
below.

“DO” CHECK BOXES

Just as you can toggle individual effects on and off to see exactly what each 
one is doing, it can often be very helpful to examine the individual steps of the 
Look Suite plug-in separately. To this end, each of the categories has a “Do” 
checkbox that you can toggle on and off.
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 If you toggle off one or more of the categories, they will remain off when 
you render the footage! It’s up to you to remember to do this. Of course, 
sometimes you may only need controls in one or two of the categories, and 
you could switch the rest off—but the truth is Look Suite is already optimized 
to ignore any settings that you haven’t changed from the defaults, so 
switching off unused categories won’t change your render times.

When you load a new Look all of the “Do” checkboxes are switched on for you 
automatically.

THE SUBJECT CATEGORY

The first category of controls is Subject. It is sometimes handy to be able to 
adjust the characteristics of the image before applying the more complicated 
effects that come later. This is where you prep the image for the abuse it is 
about to take.

The first slider is called Pre Saturation. This works much like the saturation 
controls in the color correction tools built-in to most editing applications. 
Many of the preset looks increase the contrast of your images, and a 
natural by-product of that is increased saturation. This control allows you to 
preemptively reduce the saturation of your image to pave the way for future 
effects.

The next slider is Pre Gamma. Similar to the Gamma slider in a Levels effect, 
this control allows you to even out the exposure level of your image before 
treating it.

 Look Suite’s Gamma sliders have been calibrated in percentages to easily 
allow you to invert the values. A Post Gamma value of -40% perfectly negates 
a Pre Gamma of 40%.

Look Suite likes to operate on a nice, even image that’s not too contrasty. If 
your footage already has some heavy contrast built-in, it may work better to 
correct this with the Pre Contrast slider (using the values below 0%) and then 
add the contrast back in after all the other effects.
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 Look Suite’s contrast controls are designed to never “clip,” or throw away 
image information. If you do nothing but apply a -50% Pre Contrast and 50% 
Post Contrast to your image you will wind up with exactly what you started 
with!

With all of the Subject parameters the idea is to prepare the image by making 
it as even and generic-looking as possible. This will ensure that the fun stuff 
we do later acts on your image in the way you will expect.

THE LENS FILTERS CATEGORY

Lens Filters is the deepest category in Look Suite. It contains controls for 
three emulations of common filters used on motion picture cameras. The first 
two are Diffusion filters. They are called this because they diffuse, or scatter, 
the light that is coming into the camera. This has the effect of softening some 
of the harsh details in an image and is sometimes associated with a more 
romantic feeling. The preset look Warm & Fuzzy is an emulation of the diffusion 
used on the movie Jerry Maguire, but you can take it much farther and 
simulate the heavily diffused looks of The Great Train Robbery or the ballroom 
scene in Eyes Wide Shut.

A very subtle application of a diffusion filter may not change the mood of your 
footage much at all, but can cut down on some of the harshness of the video 
original and can even hide blemishes in the skin tones of your talent.

 This is one of the great advantages of software diffusion over shooting DV 
with an on-the-lens diffusion filter—aside from giving you more control and 
flexibility, Look Suite’s Diffusion effects can actually seam over some of the 
nasty compression artifacts of video!

One of the most common types of diffusion used on motion picture camera is 
the Pro-Mist series made by Tiffen. Their line includes a White Pro-Mist and a 
Black Pro-Mist, and Look Suite offers both White Diffusion and Black Diffusion. 
These effects will not precisely match the Tiffen on-the-lens filters, but they 
are useful in the same ways.
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BLACK DIFFUSION

Black Diffusion adds an overall softness to your image without destroying 
important detail. Unlike White Diffusion, it blooms dark areas of your image as 
well as light, creating an effect that is less “bright” overall.

Diffusion filters in the real world come in varying “grades,” so the slider you 
use to introduce Black Diffusion is called Black Diffusion: Grade. Filter grades 
are commonly expressed in increments such as half, full, double, etc.—up to 
about a grade 5. The Black Diffusion: Grade slider is calibrated to be familiar 
to those accustomed to discussing diffusion filters by their grade. Of course, 
you can select whatever value you want on the slider (up to 6.0), dialing in 
your preferred diffusion amount as precisely as you wish.

 When Black Diffusion: Grade is set to zero, none of the other Black Diffusion 
settings matter—no Black Diffusion is used and no calculations are performed 
for the effect.

Black Diffusion: Size controls the amount of image that encroaches on its 
neighboring picture area. A small value will create tight, distinct “bloomed” 
areas around highlights, whereas a large value will act more as a general 
contrast-reduction effect.

Black Diffusion: Highlight Bias controls how highlights react as they are filtered 
through the Black Diffusion. Settings below 0% will cause highlights to bloom 
out a bit, as they tend to do in real life. Positive values will actually cause dark 
areas to bloom more than light ones, which can produce a very interesting, 
stylized look.

WHITE DIFFUSION

White Diffusion blooms highlights and lends a glowing quality to bright areas 
of the image. This effect is often associated with dream sequences, or 
glamour shots of classic movie actresses. White Diffusion will only make your 
image brighter—an effect which you may wish to counteract with the Post 
Gamma control.
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As with Black Diffusion, White Diffusion is set in values known as Grades 
using the White Diffusion: Grade slider.

 When White Diffusion: Grade is set to zero, none of the other White Diffusion 
settings matter—no White Diffusion is used and no calculations are 
performed for the effect.

White Diffusion: Size works very much like Black Diffusion: Size, controlling the 
size of the blooming effect.

 Note that while larger White Diffusion: Size values bloom the highlights into 
bigger areas, those highlights then become more distributed and therefore 
less intense. You may need to compensate by increasing the Grade value.

White Diffusion: Highlight Bias controls what in your image is considered 
bright enough to be affected by the White Diffusion filter. At 50% the middle 
gray values (50% luminance) will be the darkest things affected. Bringing this 
slider down to very low settings will cause the whole image to be bloomed and 
brightened, whereas high values will confine the diffusion effect to the very 
bright highlights.

GRAD

A Grad (short for gradient) is a type of filter that has more tint or coloration 
at the top than at the bottom. Placing a grad filter on a camera is a way of 
controlling the light at the top portion of the frame—usually a sky. An ND 
(Neutral Density) Grad is a simple colorless grad used to naturally darken 
the upper area of an image, which can be very handy for keeping skies from 
blowing out or overexposing on film (or video). An Amber Grad is a common 
tool for lending a sunset-like quality to an otherwise blue sky (see Bad Boys 
and Crimson Tide).
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 Although the Grad effect in Look Suite is a powerful one, it cannot bring back 
detail in a blown-out-to-white sky in your digital images. A ND Grad is one of 
the few on-the-lens filters that The Orphanage recommends using on your 
digital video camera. If you get a nice exposure on your sky, you can then use 
Look Suite’s Grad effect to colorize it in post.

Just like the Diffusion effects, you set the intensity of the Grad by grade, 
using the Grad: Grade slider. As you increase Grad: Grade you will notice that 
the Grad effect is more pronounced in the darker areas of the image than 
anywhere else—this is a simulation of how actual grad filters behave in the 
real world. To give you extra control there is a slider called Grad: Highlight 
Squelch. This slider controls how much the Grad will actually block out 
very bright highlights in your image. A value of 0% will leave the highlights 
untouched, and a value of 100% will colorize, or squelch, them completely.

 Setting Grad: Highlight Squelch very high will allow you to place color back into 
a blown-out sky, but it will be pretty obvious what you’re up to. Lower settings 
on this slider give a more naturalistic look.

 In photography, grads and other light-blocking filters are incremented in 
Filter Factors, which is a similar unit of measure to the grades of diffusion 
filters. A Filter Factor of 3 is equal to one stop of exposure, so when a 
cinematographer asks for a “6 ND,” they are requesting a filter that will 
reduce their exposure levels by two stops. While the Grade slider used in 
Look Suite to adjust the intensity of the Grad effect is inspired by this real-life 
measurement, it would actually be impossible to reliably influence your images 
in true Filter Factor increments—so adjust your Grad to taste and try not to 
think too hard.

Grad: Color is where you pick the tint of your Grad. Pay attention to the 
luminance value of the color you select, as darker colors will have a more 
pronounced effect than brighter ones.

Selecting pure black as your Grad: Color will allow Look Suite’s Grad to 
simulate the effect of an ND Grad—with the usual caveat that if your sky is 
blown out to pure white, there’s not much we can do for you.

Grad: Size controls how far down into the image the Grad extends. At 100% 
the bottom of the Grad touches the bottom of the image. Grad: Size can 
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exceed 100% for those occasions where you want more of the middle values 
of the Grad to affect even the very bottom of the image.

 Of all the effects in Look Suite, the Grad is the one you’re most likely to need 
to adjust on a shot-by-shot basis. The Grad: Size slider is a great place to do 
this—although you may also wish to keyframe the Grad: Grade slider as well.

The Grad: Fade slider allows you to control the ramping of the Grad. At 50% 
(the default) you get a nice, linear Grad. Below 50% the Grad fills in more 
heavily towards the bottom edge, and above 50% the Grad stays potent up 
top but fades more gracefully away towards the bottom.

 When Grad: Grade is set to zero, none of the other Grad settings matter—no 
Grad is used and no calculations are performed for the effect.

THE CAMERA CATEGORY

This category describes effects that take place within the camera—film stock 
types and their reactions to light. These effects are therefore calculated after 
the Lens Filters.

3-STRIP PROCESS

This one slider has the simple function of emulating the classic movie look 
that we associate with the three-strip dye transfer color process created by 
Technicolor in 1932. The Preset Look Epic uses this slider along with some 
Post Contrast and Saturation to specifically mimic the look of films such as 
North by Northwest and The Searchers.

TINT

Tint lends an overall color cast to the image, which can be a subtle effect or 
a very overpowering one. The Tint Color is, perhaps obviously, the color that 
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you are tinting your image towards, and the Tint slider is a percentage from 0 
to 100%. At 100% only the luminance of your original image is left—the Hue 
and Saturation values are taken entirely from the Tint Color.

TINT BLACK

Tint Black lends a color cast to the dark areas in your image. Like Tint, Tint 
Black is a color picker (Tint Black Color) combined with a percentage slider 
(Tint Black). There’s an extra control though, called Tint Black Threshold, and 
this slider helps determine the luminance range affected by Tint Black. Higher 
values mean more of your image is affected, although very bright areas of the 
image will never be affected.

THE POST CATEGORY

Under Post you will find a few new controls followed by the same effects 
contained within Subject, but in reverse order. You may be wondering why we 
have these redundant controls. Have no fear, all will be explained—but first 
let’s go over the two unique sliders in Post:

Warm/Cool is a simple, one-stop-shop for the most common color correction 
request—”Could we just warm that up a little bit?” As you might have 
guessed, Warm/Cool “warms up” or “cools down” your image by color 
correcting it towards or away from a nice amber tone. At 0% Warm/Cool 
is neutral and has no effect. Values below 0% gradually push your image 
towards a warm color in a gentle way that uses the mid-tones to affect the 
whole flavor of the image without changing your overall contrast level. Values 
above 0% push the image the other direction, towards a cyan tone that reads 
as cold.

You may not agree with our idea of what “warm” or “cool” is though, so we’ve 
given you an extra control. Warm/Cool Hue allows you to modulate the specific 
flavor of warmth or coolness by rotating the hue of the effect. Values below 
0% will move your image towards green, and above 0% will push it towards 
magenta. A small positive value in a cool scene will get you a “cool” that is 
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more blue than cyan, and a subtle nudge in the negative direction will yield a 
“warm” that is more golden yellow than ruddy orange.

 What if I just want to use Warm/Cool as an effect, without any of the others? 
Go ahead—if you only adjust the Warm/Cool and Warm/Cool Hue controls, 
it’s as if you’ve only applied these parts of the plug-in. In other words, no 
calculations are done for the rest of Look Suite, and your render times should 
be very fast, as if you’ve applied a very simple effect.

Post Gamma, Post Contrast, and Post Saturation work exactly like their Subject 
category counterparts. They can, up to a point, perfectly undo their equivalent 
effects in Subject—meaning a value of -50% in Post Gamma will cleanly 
correct out a value of +50% in Subject Gamma.

So what are these controls for? The relationships between the Subject and 
Post effects, and everything that happens in-between, is in many ways the 
heart of Look Suite’s power.

You will notice that many of the Preset Looks begin with negative values in 
one or more of the Subject parameters, and finish with complimentary values 
in Post. To help understand why this is so, try this out on a piece of your own 
footage:

Apply Look Suite. Twirl down Lens Filters and Gradient and set Grade to 4. 
Leave the Gradient: Color the default amber.

Now try this: Under Subject, enter a Pre Saturation value of -50%. Under 
Post, set Post Saturation to 50%.

The Pre and Post Saturation effects have cleanly cancelled one another out, 
but the look of the Gradient has changed substantially. Now try swapping the 
values in Pre and Post Saturation. The result should be an amber-colored grad 
that has a nice, subtle tone to it.
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 In Final Cut Pro 4 you can compare the effect by opening the Frame Viewer 
from the Tools menu and setting the pop-ups to Current Frame on the left 
and Current Frame w/o effects on the right so you can see the results side 
by side. Other video editors include similar preview capabilities. See the user 
guide of your video editing software for more information.

Try this same sequence using complimentary values in Gamma and Contrast 
as well. Note how the quality of the Gradient changes every time. You can also 
try bracketing any of the other Look Suite effects with these complimentary 
values: the Diffusion effects, the Tint effects, even Warm/Cool.

It’s easy to see how, using this technique, you can turn any of Look Suite’s 
various simple effects into a customized Look that is unique to your project. 
Experiment away—and if you come up with a really killer Look, email it to Red 
Giant Software, support@redgiantsoftware.com for possible inclusion in a 
future version!
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MISFIRE

OVERVIEW

Misfire adds a host of tools to your effects arsenal to simulate film damage. 
Misfire is a single complete plug-in that offers 13 different effects and a set 
of individual plug-ins for each effect category. For example, if you only want to 
apply the grain and basic scratches you can apply these as individual effects 
called Misfire Grain and Misfire Basic Scratches.

Misfire is not a perfect duplication of every type of film defect. Film defects 
are wide ranging in their appearance and include problems caused by dust, 
dirt, film wear, duplication problems, splicing, irregular exposure or improper 
storage of the film medium. These defects can show up in the frame or be 
caused by improper projection. Misfire attempts to artistically emulate a 
number of these defects.

The main Misfire plug-in offers controls for Fading, Funk, Splotches, Dust, 
Flicker, Vignette, Displacement, Grain, and 3 different types of scratches, 
Microscratches, Basic Scratches and Deep Scratches. Each category of effect 
can be turned off individually using the category switch. All of these effects 
are also offered as individual plug-ins.

We hope you find these useful. We are eager to get feedback on Misfire. 
Please let us know what you like and don’t like and what other features you 
would like to add in the future. Drop us an email to support@redgiantsoftware
.com with your comments.

FADING

Fading causes an overall lightening of your image that is exhibited as lower 
contrast. There is only a single control called Fade Amount. The default value 
is 100, lower values will lessen the effect.
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FUNK

Funk provides for tone variation across the frame. This simulates a film 
negative with lightness variation across the entire frame that may be caused 
by improper storage or in an environment where fungus or mildew could form. 
This is similar to the splotches but occurs throughout the frame and will 
persist from frame to frame. 

There is only a single control for Funk, Funk Opacity. The default is 15%. High 
values may look unnatural but feel free to adjust to taste.

SPLOTCHES

Splotches shows up as a local dirtiness or discoloration of the frame. This can 
happen on any frame and will usually only persist for a frame or two at a time. 

There are four controls for Splotches: Number, Scale, Transparency and 
Frequency. The Number value simply controls the number of splotches on any 
given frame where the scale controls the size. The Scale value is at 1.0 will 
cover about 40% of a standard DV size frame or about 16% of 2K film frame. 
The Transparency value controls the darkness of the discolored areas. You 
may need to lower the value on very bright footage (to make the splotch less 
prominent) or raise the value for very dark footage to bring out the effect. 
The last control is Frequency determines how often a splotch will appear in 
a sequence. The default value of 50 will cause a splotch to appear on half of 
the frames. Try lowering this value if you want the splotches to occur less 
frequently.

DUST

Dust essentially draws bits of black and white material on to the frame. This 
is effect is similar to the small particles that appear on film that has been run 
through a projector numerous times. The defaults are meant to generate a 
small amount of both black and white dust that is very noticeable. 
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You can control the Dust with four parameters: Black Dust Amount, White Dust 
Amount, Opacity and Frequency. The black and white amount values let you 
control the maximum number of dust particles appearing in any one frame. 
For large frame size you may want to make this value much larger to increase 
the appearance of the dust. 

The Opacity control lets you specify the transparency of the dust particles. 
The default is 100% which makes the particles quite noticeable. If you want 
the dust to look smaller in the frame try lowering this value to between 40 
and 60%. 

Frequency determines how often a dust particle will appear in a sequence. The 
default value of 50 will cause dust particles to appear on half of the frames 
similar to the splotches control. Try lowering this value if you want the dust to 
occur less frequently.

 Note that while a number of categories include a Frequency control, each 
category determines its frequency separately so splotches won’t necessarily 
appear at the same frame as dust or any other category of effect.

FLICKER

Flicker causes the image brightness to change from frame to frame. This is 
similar to the uneven brightness caused by the degradation of an old print. 

Flicker offers two controls: Frequency and Flicker Amount. Frequency operates 
the same as in the Dust or Splotches categories, where the value specifies 
the percentage of frames in a sequence that will have change. The default 
value of 50 means that half of the frames in a sequence will change in 
brightness. Flicker Amount simply controls the degree of brightness change. 
The default of 10 will cause only a small variation.
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VIGNETTE

Old film tends to exhibit a lot of darkening around the edge of the frames often 
a result of the lens and camera that were used to shoot the film. The Vignette 
category will mimic this aberration. Unlike other categories of effects, 
Vignette does not animate or change from frame-to-frame.

There are two controls available in the Vignette category: Size and Intensity. 
Size controls the overall width of the darkening where a value of zero will 
darken all the way to the center and value of 100 will not draken the frame at 
all. The Intensity control simply changes the amount of darkening. 

DISPLACEMENT

Often old or mishandled film prints can exhibit a warping of the image caused 
by a physical bend in the film frame itself. The Displacement category offers a 
very simple control for warping the image. A single Amount control specifies 
the level of warping in the image. With this control a little goes a long way. 

 This category of effect does not auto-animate so you may want to keyframe 
the Amount value.

SCRATCH STYLES

Misfire offers 3 different styles of scratches. Microscratches are very thin 
black lines, Basic Scratches generate black or white lines that move left and 
right or wiggle back and forth. Deep Scratches generates a colored scratch 
that appears to have depth, and to wiggle or move from frame to frame. The 
scratches’ can move left or right a random amount that varies from zero to 
5-7 pixels depending on the size of your image.
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MICROSCRATCHES

Film is often worn as it run through a projector creating faint black lines on 
the frame. Microscratches tries to replicate this kind of damage by creating 
faint black lines across the entire image.

This category offers just two controls: Number and Opacity. The Number does 
not correspond to the actual number of scratches but rather is a measure 
of the density of the scratches—higher numbers yield a denser field of black 
lines. The Opacity control simply changes the transparency of the lines.

 The Number and Opacity controls should be adjusted in tandem. If you raise 
the Number control, you may want to lower the Opacity or vice versa.

DEEP SCRATCHES

The Deep Scratches category generates a colored scratch that mimics a 
physical scratch on the film that has removed some of the film resist, letting 
light through that is pure in color. These tend to be close to pure green but 
you can specify any color using the Tint Color control.

You can control both the Number of Scratches and the Maximum Duration 
of the effect. The number is the specified number of scratches that will be 
drawn on the image. Maximum Duration lets you control the maximum length 
that any one scratch will appear on the image. The duration is determined 
randomly for each scratch and can be between 1 frame and the maximum 
specified number of frames in the Maximum Duration control.

BASIC SCRATCHES

Basic Scratches generates thin bright or dark lines that wiggles or move from 
frame to frame. The Invert control lets you specify either dark lines (when it is 
on) or light lines when it is off. Unlike the Microscratches or Deep Scratches 
effect, Basic Scratches will not cover the entire frame but will gently fade 
toward the top or bottom of the frame.
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The Number of Scratches and Maximum Duration control are the same as the 
controls in the Deep Scratches category.

GRAIN

When most people think of film, they think of grain. While some film stocks do 
exhibit noticeable grain, this type of effect is best used sparingly. The Grain 
category generates more than just random noise. If all you want is random 
noise, a simply noise filter applied on top would work fine—the Grain controls 
go beyond this by letting you create the multi-colored clumps associated with 
true film grain. 

Grain offers ten different controls for specifying the amount of grain and 
where it appears on your image. Color Noise lets you simply specify whether 
the grain is the same on all the color channels Red, Green and Blue. This 
control is on by default. If you turn it off, you will notice that the colored grain 
disappears and is replaced by a tinted noise, based on the Red, Green and 
Blue percentages (explained below).

The Amount control simply gives you control over the density—adjust to taste.

The next six controls are interrelated. Red, Green, Blue, Softness Red, 
Softness Green and Softness Blue specify how much and how soft the grain 
appear. The Red, Green, and Blue controls are specified as a percentage 
and these bias the Amount setting. For example, the Red control default to 
28.22%. This means that only 28.22% of the Amount value is used in the 
Red channel of your image. If these values are all the same, then the grain will 
have the same amount applied to each channel.

The Softness controls let you soften the grain on each channel. Smaller values 
mean harder edges, larger values add a more diffuse look. It is best to stick 
with small values in these controls.

Finally, you can control whether the grain is drawn in purely white or black 
areas using the Suppression Black and Suppression White percentages. The 
percentages specify the percentage of brightness or darkness in the frame 
where the grain will NOT appear. For example, 10 percent Suppression White 
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means that the grain will not draw in the very brightest pixels in the image 
and will only appear fully in areas that are 10% or less of fully white pixels in 
the image.

GATE WEAVE

When a film frame passes through a projector, sprockets outside the image 
area control the vertical motion of the frames through the projector. Over 
time, a film can be become warped or the sprockets can wear causing the 
frame to appear to move side to side. This is called Gate Weave and you can 
mimic this kind of motion with the Gate Weave effect.

There are 3 controls in the Gate Weave category: Weave Frequency, Amplitude, 
and Noise Frequency. Weave Frequency controls the speed of the left-right 
motion of the frame—small values cause the frame to move slowly, high 
values will cause the frame to move quickly from side to side. The Amplitude 
is measured in pixels. The default of five pixels will cause the frame to move 
left or right 5 pixels then return to center. The Noise Frequency will vary the 
motion by the percentage you choose. Small Noise Frequency values will cause 
a slight variation of the motion, while large percentages will cause the frame 
to appear to jitter.

POST CONTRAST

Film often appears with higher contrast than video. Over time the darkening or 
contrast change can be quite pronounced. The Post Contrast control lets you 
quickly add this effect. The only control is for Contrast. The default value is fine 
in most cases. Values beyond 50 will likely look unrealistic. 

Note that negative values are also possible with the Contrast control so you 
can cause the image to appear to wash out with negative values.
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APPENDIX

INTERFACE: LOOK SUITE

“Do”  p. 31

Subject p.32

Black Diffusion p.34

Graident p.35

White Diffusion p.34

Camera p.37

Post p.38

3-Strip p.37

Lens Filters p.33

Tint Black p.37
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INTERFACE: MISFIRE

Apply p.41 

Fading p.41 

Funk p.42

Displacement p.44

Flicker p.43

Grain p.46

Basic Scratches p.45

Dust p.42

Deep Scratches p.45

Splotches p.42

Vignette p.44

Microscratches p.45

Gate Weave p.47

Post Contrast p.47
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DVD LIBRARY

Bad Boys

Crimson Tide

Eyes Wide Shut

Face/Off

Jerry Maguire

North by Northwest

Out of Sight

Saving Private Ryan

The Great Train Robbery

The Guns of Navarone

The Searchers

Three Kings

The Matrix

Traffic
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ABOUT THE ORPHANAGE

The Orphanage was founded in 1999 when Scott Stewart, Jonathan Rothbart 
and Stu Maschwitz left George Lucas’ Industrial Light + Magic and joined 
forces to apply their skills with digital filmmaking and visual effects to their 
own creative endeavors. Now with offices in Los Angeles and San Francisco’s 
Presidio park, The Orphanage features three distinct divisions: high-end digital 
post production services for film and television, which includes visual effects 
and, of course, Magic Bullet; original motion picture, television, commercial 
and music video production and development; and digital filmmaking 
technology development and licensing. Additionally, Orphanage Spots is an 
Orphanage subsidiary focused on creating high-end visual effects for the 
music video and advertising industries.

Magic Bullet was a natural outgrowth of the primary mission of The 
Orphanage; to create high-quality entertainment using easily accessible digital 
tools. The first Orphanage film, Maschwitz’s The Last Birthday Card, was also 
the first testing ground for Magic Bullet. Following that the Orphans produced 
What We Talk About When We Talk About Love, a short film based on the 
Raymond Carver short story and directed by Stewart. For this film they took 
what they learned on Birthday Card to the next level, acquiring a PAL Sony 
DCR-VX1000p to verify their suspicions that a PAL Bullet would yield superior 
image quality. At the time, PAL support in their editing application of choice, 
Apple’s nascent Final Cut Pro, was incomplete. This situation helped institute 
another fundamental Orphanage practice—that of working closely with 
technology partners (such as Apple, Adobe and Pinnacle Systems) to keep 
pace with the rapidly evolving world of digital filmmaking. Eventually What We 
Talk About was edited in Final Cut Pro, and from that point on PAL would be 
the format of choice for SD Orphanage films.  

By January 2000, the Orphanage would arrive at in Park City, Utah to 
premiere five digital short films at Sundance and the surrounding festivals. 
Whether viewing these pieces on 35mm film or through digital projection, 
audiences were amazed at their cinematic quality and production values. This 
led to several requests from the independent film community to begin offering 
Magic Bullet post services to the outside world. To this date, nearly two dozen 
features have utilized The Orphanage’s Magic Bullet post services and have 
gone on to play at festivals worldwide including Sundance, Berlin, Cannes 
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and Toronto film festivals.  A number of these projects continued on to play 
in wider theatrical and cable release—and all of their film prints and video 
masters are direct digital Magic Bullet output.

The Orphanage has continued to perfect the Bullet throughout all of this, 
working with programmer Douglas Applewhite—another former ILMer—to 
optimize it and add new features. Every project that comes through the 
door of—or originates from within—the company is a further opportunity 
to hone the Bullet’s abilities. The Orphanage looks forward to sharing these 
improvements with the public in future releases of the software.

It is the sincere hope of The Orphanage that Magic Bullet helps you do what 
they’ve been doing since day one—make the films you want to make, the way 
you want to make them.

For more information on The Orphanage, please visit: www.theorphanage.com
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